
Upfitter Interface Module® 
The following list represents firmware v4.31 

A-UIM4-506-A 2011-2016 Ford F250-550 

B-UIM4-507-A 2017-2019 Ford F250-F550 

A-UIM4-751-A 2013-2017 1500-5500 Ram Trucks 

E-UIM4-751-A 2018-2019 Ram Trucks 

A-UIM4-654-A 2014-2018 1500-3500 Silverado/Sierra 
 

 

See UIM4 Programming Utility or contact Intermotive for latest list of supported vehicles 
 

 

Introduction 
The Upfitter Interface Module® 4 provides access to a broad range of vehicle data such as MPH, RPM, Park 
Brake, Service Brake, temperatures, transmission range, accelerator pedal, lights, ABS, MIL, etc.  Specific 
data is vehicle dependent, and by running the UIM4 Programming Utility software (free download from 
www.intermotive.net), available information on a particular chassis can easily be determined.  An upfitter 
harness provides four programmable outputs, using the UIM4 Programming Utility.  The Programmer allows 
logical combinations (AND, OR, =, >, <) of various vehicle data to control an output.  For example, one 
output can be programmed to go active when ECT>230 OR TFT>250 AND RPM>300 (any numeric values 
can be used).  This could drive a high temperature dash indicator.  Another output could be programmed to 
drive a warning buzzer/lamp when the vehicle speed exceeds some limit, such as 70mph.  Electric doors 
can be disabled unless certain safety conditions are met and so on.  A clutch pump may be disabled if RPM 
rises too high.  There are also two general purpose inputs that can be used as part of the programmable 
logic.  

www.intermotive.net 

 products@intermotive.net 
UIM4-060220-INS  

InterMotive Inc. 

12840 Earhart Ave 
Auburn, CA 95602 

Phone: (530) 823-1048 
Fax: (530) 823-1516 

Page 1 of 11 

An ISO 9001:2015 Registered Company 

UIM4 Programming Utility Instructions 
(used for configuring the 4 programmable outputs) 

Requirements 

• Java Runtime Environment (v1.6.0_18 or later [32 bit]) must be installed on your computer prior to 

running this utility.  Most PC’s already have Java installed.  The most recent version can be obtained 
for free at http://java.com/en/download/manual.jsp.  

• The UIM4 Programming Utility.  This is a free Intermotive software program that can be downloaded 

onto your PC.  The files are available from the download page at www.intermotive.net.  It is             
recommended that an “InterMotive” folder be created to store the files. 

• USB to Serial cable (part# S-H37A1) is included in an “a-IPU” kit and is a one-time purchase.  This kit is 

required for all programming and is recommended to be kept in a central location. 
 

Once the UIM4 Programming Utility has been run and the specific configuration has been created, it can be 
downloaded onto the UIM4-xxx-B module(s) with the Programming Utility. 

CAUTION 

All electronic products are susceptible to damage from Electrostatic Discharge or ESD.  Ground 

yourself before handling or working with the module and harnessing by first touching chassis 



Computer Installation 

Ensure the proper driver is installed for the USB to Serial download cable.  This driver can be found 
at: http://www.ftdichip.com/Drivers/VCP.htm 

1. To install the programming utility, unzip the UIM4 Programming Utility folder to your local 
hard drive.  

2. Create a shortcut on the desktop if necessary, but do not separate 
the UIM4 Programming Utility.exe file from the rxtxSerial.dll file! 

3. Plug in the USB cable (Part# S-H37A1) prior to starting 
the application. 

4. Double click the UIM4 Programming Utility.exe file to launch. 

5. This screen will come up. 

 

If the program does not launch, close all applications and reinstall the 
Java Runtime Environment and the UIM4 Programming Utility. 

 

Setting the UIM4 Programming Utility Pin Configurations 

To view a video on tips for configuring the module, go to 
www.Intermotive.net  

1. Under the “Home” tab, select the model year, manufacturer, model, 
and engine size of the vehicle the UIM4 will be installed in. 

2. Click the “Create Configuration” button. 

3. This screen will come up. 

4. Configure each pin as desired.  See the following page for more 
information.  Press the Enter button after each entry. 

Note: CTO (Clean Tach Out) can only be programmed on pin 3.   
2.2 Hz per MPH can only be programmed on pin 1.       

5. Select “Save Configuration” under the “File” tab. 

6. Enter a configuration name (Max. 16 characters) and click “OK”. 

7. Review the configuration summary and click “Save Configuration”. 

8. Enter a filename and choose a location that will be easy to locate. 

9. Under the “File” menu, select  “Save Configuration Summary”. 

10.  Double click the .imc file previously configured. 

11. Enter Company Name, phone number, and notes and click the ‘OK’ button.  Note:  Enter the vehicle 
model year, model, and engine in the notes section. 

12.  Enter a file name and click the ‘Save’ button. 

13.  Click the ‘Open File’ button. 

14.  Right click on summary and select ‘Print’. 

15.  Cut the printed label and place it in the bag attached to the 8-pin connector. 
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Pin Mode Settings — UIM4 Application Software 

The outputs can be set for various modes, as described below.  Momentary mode is the most commonly used, 
where an output is ‘active’ only when the proper conditions have been met.  

 

Momentary:  Output follows condition set but with a turn on delay, and a turn off delay.  Setting ‘On Delay’ 
and ‘Off Delay’ to zero causes the output pin to simply “follow” the condition set being true (ON) and false 
(OFF). 

 

 

Time Hold:  The output pin goes ON after the conditions become true, and stays ON for the selected ‘On 
Time’, regardless of the conditions.  Off Time is Not Applicable. 

 

 

 

 

 

Desktop Programming the UIM4           

The InterMotive “a-IPU” kit is sold separately and allows programming 
the UIM4 on your desktop.  It consists of a 12VDC wall adapter and 
download cable and works with the UIM4 programming software utility.    

Note: Do not have the UIM4 Programming Utility opened until 
instructed to do so. 

1. Plug the Module Desktop Power/Ground Supply inverter into a 120V 
AC power source.  

2. Locate the 4-Pin Female connector on the module but do not 
connect the AC adapter to the UIM4 module until indicated in the 
following steps.  

3. Plug the phone jack end of the download cable into the J2 COMM 
port of the UIM4 module and the USB end into your PC. 

J2 COMM Port 



Loading Configuration file into the UIM4 

Open the UIM4 Programming Utility.  Under the “Download” tab on the UIM4 Programming Utility, choose the 
COM Port the USB cable is connected to. 

Note: This can be determined on Windows 7 by right-clicking on ‘Computer’ and selecting ‘Properties.’ From 
this window click on ‘Device Manager.’  In the Device Manager window, expand the ‘Ports’ menu and the 
download cable will display as ‘USB Serial Port (COM#).’ 

Click the ‘Open File’ button. 

1. Open the UIM4*.ims or configuration file to load on the UIM4-xxx-B module. (This file must already be 
loaded on the computer) 

 Click the load button on the computer screen.  “Waiting” will come up next to the progress bar.  This 

means the program is waiting for the download cable to be plugged into the UIM4 module. 

 Plug in the 4 pin connector of the power adapter into the UIM4-xxx-B module.  The progress bar on the 

computer screen will display status as the configuration loads and takes approximately 2 seconds or less. 
Configuration is loaded once the screen says “DONE” and programming is complete. 

 To verify that the correct data was loaded into the module, disconnect the 4 pin connector from the 

module and press the ‘Get” button on the screen.  Plug in the 4 pin connector and the information 
will be displayed. 

  To program another module with the same configuration file, start with step 2. 
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UIM4 Module 

Remove the lower dash panel below the steering column area and find a suitable location to mount the UIM4 
module. Locate the module in an area away from any high heat sources (engine heat, heater ducts, etc.).  Do 
not mount the module until all wire harnesses are routed and secure.  The last step of the installation is to 
mount the module.  
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Data Link Harness (4-pin connector) 

The provided UIM4 Data Link harnesses vary from model to model, depending on which chassis the UIM4 is 
being installed. 

1. Locate the vehicles OBDII Data Link Connector.  It will be located 
below the lower left dash panel.  

2. Remove the OEM Data Link connector, and mate it to the UIM4 
Data Link harnesses red connector.  Ensure the connection is 
fully seated and secure with the supplied wire tie.   

3. Mount the pass-through connector from the UIM4 Data Link   
Harness in the former location of the vehicle’s OBDII connector. 

4. Secure the UIM4 Data Link harness so that it does not hang below 
the lower dash panel. 

 

NOTE: Do NOT plug the Data Link harness into the 4-pin connector on the UIM4 module.  This will be done at a 
later step. 

Installation Instructions 

Disconnect vehicle battery before proceeding with installation 

IMPORTANT—READ BEFORE INSTALLATION 

It is the installer’s responsibility to route and secure all wiring harnesses where they cannot be damaged by 
sharp objects, mechanical moving parts and high heat sources. Failure to do so could result in damage to 

the system or vehicle and create possible safety concerns for the operator and passengers.  

Avoid placing the module where it could encounter strong magnetic fields from high current cabling connected 
to motors, solenoids, etc. Avoid radio frequency energy from antennas or inverters next to the module. Avoid 

high voltage spikes in vehicle wiring by always using diode clamped relays when installing upfitter circuits. 

Gateway Plug and Play Harness (B-UIM4-507-B) 

1. Locate the vehicles Gateway Module (C2431). It will be mounted below the lower left  dash panel.  

2. Remove the harness behind the Gateway module by pressing the locking tab and pulling outward.  
3. Plug the Female side of the InterMotive Gateway Harness into the back of the Gateway module.  Ensure the 

connection is fully seated and secured by the locking tab.  
4. Plug the Male side of the InterMotive Data Link Harness into Gateway harness.  

5. Secure the BOM Gateway harness so that it does not hang below the lower dash panel.  

Gateway Harness 

Gateway Module 

InterMotive Plug and Play Gateway Harness 
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Plug and Play Harness (E-UIM4-751-A) 
 

1. Locate the vehicle’s OBDII Data Link Connector.  It will be mounted below the 

lower left dash panel.       

2. Remove the mounting screws for the OBDII connector.  Plug the Red connector 

from the E-UIM4-751-A Data Link Harness into the vehicle’s OBDII connector.  

Ensure the connection is fully seated and secure with the supplied wire tie. 

3. Mount the Black pass through connector from the E-UIM4-751-A Data Link Harness in the former location of 

the vehicle’s OBDII connector. 

4. Secure the E-UIM4-751-A Data Link Harness so that it does not hang below the lower dash panel. 

5. Plug the free end of the Data Link Harness into the extended harness which then plugs into the mating 

4-pin connector on the E-UIM4-751-A module. 

 

6. Locate the STAR connector bank in the location shown (next to the 

Park Brake). 

 

 

 

 

 

 

 

 

 

 

 

 

7. Plug the 2-pin E-UIM4-751-A connector into one of the unused 

ports on the upper bay towards the rear of the vehicle. 



8-Pin UIM4 Connector Pin-Out Definition 

This connector contains the UIM4’s 4 output pins.  Each output is rated at 1/2A and is intended to drive relay 
coils or other low current loads.  Note that Pin 3 and 7, unless configured other wise are active low (ground) 
while the rest are active high (12V).  Note: when driving relays, a diode-protected type must be 
used.  InterMotive recommends DigiKey #PB682-ND Relay. 

The 4 outputs are defined as follows: 

• Pin #1 (Orange wire) Configurable Output, Active High 

• Pin #2 (Purple wire) Configurable Output, Active High 

• Pin #3 (Yellow wire) Configurable Output, Configurable Active Low or High 

• Pin #5 (Red wire) fixed jumper to pin 6 

• Pin #6 (Red wire) fixed jumper to pin 5 

• Pin #7 (Green wire) Configurable Output, Configurable Active Low or High 
 

Connect the desired outputs to vehicle equipment as needed.  Tape up unused leads.  When connecting to 
relays, use relays with appropriate kick-back suppression, such as Digikey #PB682-ND.  Unsuppressed relays 
will induce very high voltage spikes throughout modern vehicles sensitive computer electronics and should not 
be used, per Ford, GM, SAE, etc.   

The default configuration for the 4 outputs are as follows: 

• Pin #1 (Orange wire) VSS — 2.2Hz/MPH 

• Pin #2 (Purple wire)  Trans Range=Reverse 

• Pin #3 (Yellow wire) Clean Tach Out, 0-12V pulsed 

     CTO = ((RPM/2)*#Cyl) = pulses per minute.  E.G. 600rpm = 2400 (8 cylinders) 

• Pin #7 (Green wire)  Service Brake  = Applied 
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Input Definition 

The 8 pin connector contains the UIM4’s 2 discrete wire inputs. Both inputs are active low. These inputs 
can be used as part of the programmable logic to configure the output pins.    

• Pin #4 - (Blue/White stripe) Input 1, Active low 

• Pin #8 - (Brown/White stripe) Input 2, Active low 

Connect inputs as needed.  Tape up unused input wires. 



Initial Installation Power-Up 

When the UIM4 module is first plugged in, it attempts to acquire the vehicles VIN to interpret vehicle data on 
the OBD network for five minutes. If Vin is not received then the module will go to sleep.  The key must be in 
the Run position for network traffic to be present. (engine off is OK) 

1. Turn the ignition switch to the Run position. 

2.  Plug the 4 pin data link connector into the module 

• If the module LEDs “scroll” , then it has NOT acquired a recognized VIN.  The chassis may be a new 
Model Year which the module does not recognize, or the chassis has an unrecognized engine.  Ensure 
your chassis is listed at the top of page one of these instructions.  Contact Intermotive Tech Support for 
assistance. 

• If no LEDs come on when the module is plugged in and powered up, it is working properly.  Proceed to 
post installation testing. 

Reconnect the vehicle battery 

UIM4 Module Mounting 

Ensure all the harnesses are properly connected and routed, and are not hanging below the dash area.  Mount 
the UIM4 module using screws or double sided tape. Reinstall the lower dash panel. 

InterMotive Inc. 

12840 Earhart Ave 
Auburn, CA 95602 

Phone: (530) 823-1048 
Fax: (530) 823-1516 

Page 8 of 11 

www.intermotive.net 

 products@intermotive.net 
UIM4-060220-INS  



UIM4 Post Installation Testing 

1. Turn the ignition ON to wake up and initialize the UIM4 module. 

2. With the conditions met, ensure that all desired outputs are responding correctly per their programmed 
condition set. (e.g., default condition of output 4 goes low when Service Brake is pressed) 

The UIM4 is properly installed only if it passes the above tests.  If any irregular operational issues persist, 
recheck the condition set configuration.  Contact InterMotive at 530-823-1048 for technical assistance. 
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Diagnostics 

To enter diagnostic mode, momentarily short the two test pads together on the 
module (look for “Test” on the printed circuit board) with the ignition on.  There 
are eight ‘pages’ of diagnostic data.  Each time the test pad is momentarily 
grounded the module will advance to the next ‘page’.  The Status LED will flash 
the page number. (e.g. the Status LED will flash 5 times when in ‘page’ 5) 
 

Page 1 
 

The on-board LED’s will light when a corresponding load is active: 
 
LED1   =  Output #1 
LED2   =  Output #2 
LED3   =  Output #3 
LED4   =  Output #4 
 

Page 2 
 

The on-board LED’s will light when corresponding vehicle data is detected: 
 

LED1  =  VSS (vehicle speed sensor) 
LED2  =  RPM 
LED3  =  ECT (engine coolant temperature) 
LED4  =  TFT (transmission fluid temperature) 
 
Page 3 
 

The on-board LED’s will light when corresponding vehicle data is detected: 
 
LED1  =  FL (fuel level) 
LED2  =  AAT (ambient air temperature) 
LED3  =  APP (accelerator pedal position) 
LED4  =  Park Brake 
 
Page 4 
 

The on-board LED’s will light when corresponding vehicle data is detected: 
 
LED1  =  Service Brake 
LED2  =  AC 
LED3 =   ABS 
LED4 =   MIL (malfunction indicator lamp) 
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Diagnostics (Continued) 

Page 5 
 

The on-board LED’s will light when corresponding vehicle data is detected: 
 

LED1  =  Transmission Range 

LED2  =  Key Position 

LED3  =  EOP (engine oil pressure) 

LED4  =  Driver Seat 
 

Page 6 
 

The on-board LED’s will light when corresponding vehicle data is detected: 
 

LED1  =  Passenger Seat 

LED2  =  Driver Belt 

LED3  =  Passenger Belt 

LED4  =  Turn Signal 
 

Page 7 
 

The on-board LED’s will light when corresponding vehicle data is detected: 
 

LED1  =  VIN PnR Active 
  

Page 8 
 

Output Trouble Codes 
 

If there is an issue with one of the UIM4 outputs, the status LED will flash a two digit code while in diagnostic 
mode, page 8.  A 1-1 code means everything is working properly.  The first digit flashed will correspond to the 
output number and the second digit will indicate the specific problem.  The second digit can be: 
 

• 2 - Output fault (overcurrent or overvoltage) 

• 3 - Invalid data (The data associated with the output is invalid) 

• 4 - Data timed out (The data associated with the output has timed out) 

• 5 - Unsupported data (The data associated with the output is not supported on the current    

          vehicle) 

Scrolling LED’s may indicate one of the following errors: 

• LED’s scrolling sequentially one at a time indicates that an invalid or incomplete VIN was captured. 

• LED’s scrolling from the middle outward indicates a configuration error.  This can be the result of 
configuring the UIM4 for one chassis, but installing it in a different chassis.   

 

Solid LED’s may indicate one of the following errors: 

• LED’s 1 and 3 indicates that the VIN was not recieved 

• LED’s 3 and 4 indicates an IO Integrity Check Failed 

• LED’s 1 and 4 indicates an Unknown Configuration file name 

UIM4 Operation 

Turning the vehicle ignition ON will wake up and initialize the UIM4 module.  Outputs are controlled based 
on the module’s configuration created using the Intermotive UIM4 Programming Utility program.   

When the key is turned OFF,  the UIM4 module will go into a low power sleep mode and it’s outputs will shut 
off.  This may take up to five minutes, and the Diagnostic LED’s (if active) on the module will go out once in 
sleep mode.  Other vehicle activity such as opening doors, inserting key in the ignition, etc. may delay sleep 
mode. 
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